
 Activity 1.1 Guide 

 Principles and Rules of Copyright   1 - 71 

Principles and Rules of Copyright 

Copyright is protection for intellectual property. 

Intellectual property consists of anything an individual has written or created. It might be music, text, pictures, 
photographs, sounds, and so on. 

Fair use doctrine is part of the copyright laws. It states that limited portions of material may be used without written 
permission for certain purposes, such as reporting the news or schoolwork. It doesn’t define “limited,” though, so be 
sure you don’t overuse material. The fair use doctrine requires you to give credit to the author or creator of any 
material you use. 

Derivative works are copyrighted materials that have been altered or changed. Such material is protected by 
copyright laws. If you alter a copyrighted photograph by using computer software, that photograph is still protected, 
and you may not use it without written permission. 

Academic standards for copyrighted material are higher than others. Because scholars and researchers study so 
many different ideas and are responsible for sharing those ideas with the world, they are required to satisfy higher 
standards of honesty. They must give credit not only when quoting someone else’s exact words but also for the 
ideas those words represent. As a researcher, you cannot paraphrase what someone else says and not give credit for 
it. 

Bibliographies are lists of sources that have been used in research. When using the Internet for research or for 
design work, you need to give credit where it is due. Often, people who use graphics and images from the Internet 
for publication on their own web page create a list of image credits rather than a bibliography. 

Rules of Copyright 

1. You cannot use copyrighted material without written permission from the creator of the material (or from its 
copyright holder). 

2. Material can be protected even if it does not display the © symbol. Even if no mention is made regarding 
copyright, you must assume that all material from another source is protected. 

3. Penalties for violating copyright laws can range from mild to severe. If you break the copyright law, you might 
simply receive an e-mail message from the author asking you to stop using the material. If you publish the 
material on a website, the webmaster might shut down your site. Or you could be sued by the author or 
prosecuted by federal authorities. 

4. To make sure you are not violating any copyright law, it is important that you do the following: 

• Write or send e-mail to the author or creator and ask permission to use the material. Do not use it until you 
are given permission.  

• Follow the directions on the site regarding use of material. You might be asked to create a link on your 
page or to notify the author or creator.  

• Most important: Do not use any material if you don’t have written permission.  

5. To copyright your own material, the copyright notice for visually perceptible material must contain one or more 
of the following elements: 

• The symbol © (the letter C in a circle), or the word “Copyright,” or the abbreviation “Copr.”; and 

• The year of first publication 

• The name of the owner of copyright 

 Example: © 2005 Macromedia, Inc. 

• Phonorecords and sound recordings use the letter P in a circle, and 
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• The copyright notice should be affixed in such a way as to “give reasonable notice of the claim of 
copyright.”  

For more information on copyrights, visit the United States Copyright Office on the web at www.copyright.gov.
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Internet Citations 

Any information you use from a book or magazine for a report should be noted or cited in your bibliography. Citing 
information means you are giving credit for the work to its author. There are specific forms to follow for each kind 
of source. 

Citation format 

Be sure you fill in the citation exactly as it is written, with information from your source. You must follow your 
school’s preferred citation method exactly. What follows are examples of citation formats for specific Internet 
resources. 

World Wide Web 

Author. Title of item. [Online] Available http://address/filename, date of document or, if not available, date of 
download. 

Example: 

Cintas, Benjamin. The Cold War Revisited: A splintered Germany. [Online] Available 
http://usa.coldwar.server.gov/index/cold.war/countries/former.soviet.block/Germany/ 
germany.htm, November 5, 1996. 

Online image 

Description or title of image. (Online Image) Available http://address/filename, date of document or, if not 
available, date of download. 

Online sound 

Description or title of sound. (Online Sound) Available http://address/filename, date of document or, if not 
available, date of download. 

Online video clip 

Description or title of video clip. (Online Video Clip) Available http://address/filename, date of document or, if not 
available, date of download. 

Other Resources to Cite 

 E-mail 

 Newsgroups 
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Sample Student Document 

Filename: planetary_nebula_mz3.jpg 
File size: 35.5 KB 
Found at http://heritage.stsci.edu/2001/05/index.html 

 
Planetary Nebula Mz3 by Hubble Heritage Team. Copyright 2001 by NASA and Space Telescope Science Institute. 

 

 
Filename: trainingcafe_header.gif 
File size: 6.1 KB 
Found at http://www.trainingcafe.com  

 
Training Cafe site logo. Copyright 2004 by Macromedia, Inc. 
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Filename: nameplate.png 
File size: 25.5 KB 
Found at http://www.trainingcafe.com/macromedia/png.htm 

 
Sample PNG file. Copyright 2005 by Macromedia, Inc.
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Scanning 

Gather images from magazines, newspapers, or books, created artwork, or found objects (leaves, flowers, and so on) 
to practice scanning and to create graphical content to include in future projects. You will scan the images and 
objects and produce an individual body of work (electronic files and folders with original materials). 

 

 

 

 

 

PLAN 

Ask Yourself: 

 What message do I want to get across? 

 Select image or object. 

 Does this image tell the story? Focus on the message. 

 Does it tell the same story as another image? 

 How am I going to use this image? Displayed on a monitor? Printed? 

 Will I need to modify this image again for another purpose? 

 Is there any extraneous information in the image? 

 Are there any distracting details? 

CAPTURE 

Preview Scan: 

 Turn on the scanner. 

 Position the image or object on the surface. 

 Start the scanner software (if it did not already start when the scanner was turned on). 

 Set the scan mode. 

 Scan. 

 Set the final size. 

 Set the resolution. 

 Final Scan: Scan again to acquire the scan you will actually use. 

Plan Capture 
(Scan) 

Edit Save 
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EDIT 

Edit Image: 

 Start the image-editing software. 

 Correct color, if needed. 

 Add special effects. 

 Resize, if needed. 

SAVE 

Save Files: 

 Save as a file I can make changes to in the future. 

 Save as a web-ready file. 

 Save as a print-ready file.
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How to Scan Images without Image-Editing Software 

1. Lift the scanner cover. Check the orientation for the placement of the image. Notice the orientation hash marks 
etched into the plastic frame around the glass portion. 

2. Place the image on the glass. Check to be sure it is lined up on the glass. 

3. Press the Scan button (typically on the far left side of the row of buttons). If there are no buttons, you should 
see a dialog box where you can select the next step. 

4. The scanner lamp turns on and warms up. Wait for the image to be completely scanned. 

5. The scanner takes a preview scan. 

 Note: Now you can make your first adjustments. Cut away the parts of the image you do not want to include in 
the final scan. Reset the resolution or scan type as necessary. 

6. Take a final scan. 

7. Save the image as TIF (TIFF), GIF, or JPEG. These are the most common file types. 

8. If you have image-editing software, you can open the scanned file and use the image editor to make edits.
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Fireworks 8 Optimize Panel 

Student Name: ________________________________________________ Date: _______________________ 

Label the options for GIF optimization. 

 

 

Label the options for JPEG optimization. 
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Fireworks 8 Optimize Panel 

You can use the Optimize panel to select your optimization settings. The first step is to determine which type of file 
you plan to export, such as GIF or JPEG. You can then select the detailed settings. GIF images are generally used 
for line art and images with solid colors. GIF images can contain transparent areas and can be used for animation 
files. The disadvantage of GIF images is they are restricted to 256 colors. JPEG is generally used for photographic 
images or images with gradients and more colors. JPEG files cannot be transparent or animated. 

Options for GIF Optimization 

 

 

 

 

Figure 1 GIF Optimize panel 

 

 

 

 

 

 

 

 

 

 

 

Figure 1 GIF Optimize panel 

 

Settings: Use Settings to select a preset image-quality setting for export. For GIF, these include GIFs Web 216, GIF 
WebSnap 256, GIF WebSnap 128, GIF Adaptive 256, and Animated GIF WebSnap 128. 

Matte: If you want to anti-alias an image for multiple exports with different-colored backgrounds, click the Matte 
color box and select a color for the background of the image. This is useful if the image will appear on web pages 
with different-colored backgrounds. 

Colors: Control the number of colors in the image. This number is automatically configured from the Settings 
selection. Decreasing the number of colors decreases the file size and can lower image quality. 

Dither: The Dither option is useful for images with many color gradations. Dithering approximates colors not in the 
current color palette by alternating two similar colors. Increasing the Dither setting can greatly increase file size. 

Loss: Lower the image quality on export. Higher loss settings can yield smaller files but lower image quality. A loss 
setting between 5 and 15 typically yields the best results. 

Export file format 

Indexed palette 

Remove color from 
transparency 

Select transparent 
color

Snap to web-
safe

Lock 
color

Edit 
color

Add color 

Delete color 

Add color to 
transparency 
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Transparency: Remove the background color or halos around an image so in a web browser the background of the 
web page is visible through those areas. (This capability is a key advantage of exporting images as GIFs.) Index 
Transparency removes the background color. Alpha Transparency removes the background of an image if its canvas 
color is transparent. Use the Add to Transparency button to remove specific colors from the image. 

Options for JPEG optimization 

 
Figure 2 JPEG Optimize panel 

Settings: Select from preset image-quality settings for export. For JPEG, these include JPEG Better Quality and 
JPEG Smaller File. 

Matte: If you want to anti-alias an image for multiple exports with different-colored backgrounds, click the Matte 
color box and select a color for the background of the image. This is useful if the image will appear on web pages 
with different-colored backgrounds. 

Quality: Adjust the quality of the image. Lower quality decreases file size; higher quality increases file size. 

Selective Quality: Adjust the quality of only the selected part of the image while leaving the rest of the image intact. 
Used with a JPEG mask. 

Smoothing: Blurs hard edges in the image and reduces file size.
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How to Optimize GIF Images 

GIF (Graphic Interchange Format) is a graphical file format best used for images with large areas of solid, flat color, 
such as simple illustrations, logos, and text. With Macromedia Fireworks 8, you can compare different versions of 
the same graphic to create the best quality with the smallest file size. Before optimizing, complete the graphic (size, 
effects, color, and design). 

Optimize a GIF Image 

1. Open a completed graphic in Fireworks. 

2. On the Optimize panel, select GIF from the Export file 
format menu. Then select the type of GIF you want from
the Indexed Palette menu. Adaptive or Web Adaptive is 
best for most small web images. 

3. Select the 4-Up button to compare different versions of 
the image (Figure 1). Make sure the image is visible. (If 
necessary, use the Hand tool to drag the image into the 
middle.)  

4. Use the Pointer tool to select each of the three alternate 
versions of the original image, and try different settings 
in the Optimize panel to find the smallest file size with 
the most acceptable quality: 

 To adjust the image for many color gradations, 
increase the Dither setting. 

 To make the file smaller, increase Loss (usually 
between 5 and 15). 

 To remove the background color or halos around 
the image, select Index Transparency. 

 To remove specific colors from the image, use the 
Add Color to Transparency button. This capability 
is a key advantage of exporting images as GIFs. 

 As you try different settings, note the file size and 
download time for each quality level. 

5. To export the image version you prefer, click it and 
select File > Export. Name the file with a .gif 
extension. 

6. To save the richest version of the file, select File > Save
As and save the image as a Macromedia Fireworks PNG 
file (with a .png extension). 

 

 

Figure 1 Comparing GIF images 

 

 

4-Up button 
Add color to 
transparency 
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How to Optimize JPEG Images 

JPEG (Joint Photograph Experts Group) is a graphical file format best used for photographs or for images with 
subtle changes in color, gradations, or lighting. With Macromedia Fireworks 8, you can compare different versions 
of the same graphic to create the best quality with the smallest file size. Before optimizing, complete the graphic 
(size, effects, color, design). 

Optimize a JPEG Image 

1. Open the completed graphic in Fireworks. 

2. On the Optimize panel, select JPEG from the Export 
file format menu. 

3. Select the 4-Up button to compare different versions of 
the image. Make sure the image is visible in the display 
area (Figure 1). (If necessary, use the Hand tool to drag 
the image into the middle.) 

4. Use the Pointer tool to select each of the three alternate 
versions of the original image, and try different settings 
in the Optimize panel to find the smallest file size with 
the most acceptable quality.  

 From the Settings menu, select JPEG – Better 
Quality or JPEG – Smaller File for preset Quality 
values. 

 Try other values for the Quality setting. 

 To make the file smaller, increase the Smoothing. 

 As you try different settings, note the file size and 
download time for each quality level. 

5. To export the image version you prefer, click it and 
select File > Export. Name the file with a .jpg 
extension. 

6. To save the richest version of the file, select File > Save 
As and save the file as a Macromedia Fireworks PNG 
file (with a .png extension). 

 

 

 
Figure 1 Comparing JPEG images 

 

4-Up button 
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Use a JPEG Mask for Further Optimization (optional) 

You can further optimize the size of a graphic by selecting a specific area of the image and changing its quality 
setting. 

1. Click the Original button to return to the (single) 
original image. 

2. Using the Marquee tool, outline the point of interest in 
your image. 

3. With the point of interest selected, select Select > Select 
Inverse. This selects everything except the point of 
interest of the image. A marquee surrounds the inverse 
selection (Figure 1). 

4. To make changes only to the region outside the point of 
interest, select Modify > Selective JPEG > Save 
Selection as JPEG Mask. A highlight color appears on 
everything except the point of interest of the image. 

5. On the Optimize panel, you can now make changes to 
the Selective Quality. Reducing this number retains the 
image quality of the point of interest but reduces the 
quality of the background and thereby reduces the file 
size. Click the Preview tab to see the effect of your 
changes. 

 
Figure 1 Inverse selection 
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Fireworks 8 Tools 

Student Name: ___________________________________________ Date: _______________________________ 

The Tools panel contains the main tools to create and modify images. 

 

Identify the selection, movement,  
and transformation tools: 

 

 

Identify the image modification tools: 

 

 

 

 

Identify the drawing and writing tools: 

 

 

 

Identify the interactive objects tools: 

 

 

Identify the color tools: 

 

 

 

 

Identify the view tools:
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Fireworks 8 Panels 

Floating and Docked Panels 

Panels provide easy access to controls that help you edit selected objects or elements of the document. You can use 
panels to work on frames, layers, symbols, color swatches, and more. Each panel can be dragged, so you can group 
panels together in custom arrangements. By default, the panels are docked to the right side of the workspace. You 
can undock panel groups, add panels to a group, undock individual panels, rearrange the order of docked panel 
groups, and collapse and close panel groups. To undock a panel, drag the panel gripper in the upper left corner of 
the panel’s title bar. Many of the panels are tabbed, with two or more panels combined. 

Tools Panel 

The Fireworks Tools panel is divided into clearly labeled sections for easy tool selection. If the Tools panel is not 
visible, you can display it by selecting Window > Tools. To select a tool, just click it or use the shortcut key shown 
in parentheses. If a tool has a small black triangle in the bottom right corner, it is part of a group of tools; click and 
hold down the mouse over the tool to access the pop-up tool group.
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Selection, movement, and 
transformation tools: 

Pointer tool (black arrow): Click an 
object to select it. Drag a selected object 
to move it. 

Scale tool: Enlarge or reduce an object, 
rotate, flip, distort or skew objects or 
groups. 

Subselection tool (white arrow): Select 
and move points of an object or edit 
paths between adjacent points. 

Crop tool: Remove the part of an image 
outside a selected rectangular region. 

Drawing and writing tools: 

Line tool: Draw straight lines. 

Rectangle tool: Draw rectangles. Click 
and hold the small arrow at the bottom 
right to select a different shape to draw. 

Freeform tool:  

Pen tool: Click to place points; the Pen 
tool connects successive points with 
straight lines. Drag a point to form a 
curve. 

Text tool: Type text. 

Knife tool: Cut a path in two or more 
paths. 

Interactive objects tools: 

Rectangle Hotspot tool: Draw a special 
area on top of an image that can be 
clicked to link to a new web page. 

Hide slices and hotspots tool: Hide all 
slices and hotspots drawn on an image. 

Slice tool: Draw slice areas on an image 
to enable user interaction with the image 
on a web page. 

Show slices and hotspots tool: Show all 
slices and hotspots drawn on an image. 

View tools: 

Hand tool: Move the visible portion of 
an image without using the document 
scroll bars. 

Zoom tool (magnifying glass): Zoom in 
or out for a closer or farther view of an 
image. 

 

 
 

Figure 1 
Tools panel 

Three top icons: Standard Screen mode, 
Full Screen with Menus mode, or Full 
Screen mode. 

Image modification tools: 

Marquee tool: Select a rectangular region 
of pixels. Press and hold the small arrow at 
the bottom right to select a different shape 
for your selection tool. 

Magic Wand tool: Select pixels of a 
similar color. 

Pencil tool: Draw a vector path with a 1-
pixel stroke. 

Blur tool: Blur the focus of parts of an 
image. 

Lasso tool: Similar to Marquee tool, but 
lets you freeform-select an area of pixels. 

Brush tool: Select from a variety of brush 
strokes, such as spray paint, calligraphy, 
crayon, and air brush. 

Eraser tool: Erase parts of an image. 

Rubber Stamp tool: Duplicate an area of an 
image. 

Color tools: 

Eyedropper tool: Sample a color from 
existing pixels. You can sample a 1-pixel, 
3x3, or 5x5 pixel area. The sampled color 
appears in all Stroke Color or Fill Color 
boxes throughout Fireworks.  

Paint Bucket tool: Change the color of 
selected pixels. 

Stroke color: Set the color of the outline of 
an object. 

Fill color: Set the color of the region 
inside an object. 

Three bottom icons: 

Set Default Stroke and Fill Colors: 
Automatically set colors for stroke and fill; 
defaults are black for stroke and white for 
fill. 

No Stroke or Fill: A white box with a red 
line means there is no color (completely 
transparent). You cannot modify a stroke 
or fill with no color. 

Switch Stroke and Fill Colors: Swap the 
stroke and fill colors. 
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Property Inspector 

The Property inspector displays options that change according to the current object or tool selection. Open a 
document, and the Property inspector displays document properties. Select a tool, and it displays tool options. Select 
a vector object, and it displays options such as stroke and fill. You can change these and other options right from the 
Property inspector. By default, the Property inspector is visible, but you can hide or show it by selecting Window > 
Properties. The following examples show the properties for a text object (Figure 2) and a rectangle shape (Figure 
3). The options vary depending on the type of object or tool you have selected. 

 
Figure 2 Text Property inspector 

 

 
Figure 3 Rectangle shape Property inspector 

The left side of the Property inspector provides information about the selected object. You can also use this area to 
size or position the object on the canvas. 

Fill: Change the Fill color by clicking the color box. For example, you can select the fill type for a shape, such as 
solid, patterned, or dithered, from the menu beside the color box. This menu also provides various gradient effects. 
Other options include changing the type and amount of texture. 

Stroke: Change the Stroke category or color. Change the Tip size (thickness of the stroke) by typing a number in the 
text box beside the color box or by clicking the down arrow and then setting the slider. Select the Stroke category, 
such as pencil, felt tip, or crayon, from the menu on the upper right. Other options include changing the edge 
softness, the type and amount of texture, and the degree of corner roundness. 

Filters: Add effects by clicking the Add Live Filters button (the plus sign). You can add filters to either the inside or 
the border of objects. Filters include glows, shadows, bevels, and color adjustments. Delete existing filters by 
selecting the filter and clicking the Delete Current Selected Live Filter button (the minus sign). After you select a 
filter from the menu, you can vary the opacity and blend mode. 
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How to Build a Nameplate 

To build a nameplate, you create a shape, add text, and then add effects to the shape and text. You create the design 
by adding various effects and colors to the fill, stroke, and text. 

Build a Nameplate 

1. Start Macromedia Fireworks, open a new document, and 
specify canvas dimensions (at least 400 pixels wide and 
200 pixels high). 

2. Save the file. 

3. Create a background for your nameplate by using the 
Rectangle tool from the Tools panel. Leave some white 
space on the canvas around the rectangle to add effects 
later. 

 The rectangle shows a light blue outline with small blue 
squares in the corner when it is selected. 

4. Change the color of the stroke (outline) or the fill 
(inside) of the rectangle by using the Stroke Color and 
Fill Color tools on the Property inspector or the Tools 
panel. 

5. To add your name to the rectangle, select the Text tool 
on the Tools panel; then click and drag to draw a text 
box over the rectangle you just created. Using the 
Property inspector, select the font, size, color, and style 
you want. Type your name. 

 (The example in Figure 1 was created with Comic Sans 
MS, 32pt, white, bold, and all caps.) 

6. To move your name around the rectangle, select the 
Pointer tool on the Tools panel, select the text object, 
and drag it to the desired position. 

7. To customize the look of the nameplate, select the 
rectangle or text; then click the Add live filters button 
in the Property inspector, select a filter, and select your 
settings. You can also change the type of fill and stroke.

 

 
Figure 1 Text and rectangle 

 



Activity 1.5 Guide 

1 – 96   How to Build a Nameplate 

 

 The illustrated nameplate uses a Satin fill pattern and no 
stroke, with a feathered edge and Grain texture for the 
rectangle (Figure 2). The text on the nameplate uses the 
Drop Shadow effect (Figure 3). 

8. After you complete all the desired effects, select Modify 
> Canvas > Trim Canvas from the main menu. This 
action removes any excess white space around the 
image. 

9. Save the nameplate. 

 
Figure 2 Rectangle Property inspector 

Figure 3 Text Property inspector 
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How to Create Effects 

Effects are applied to graphic and text objects, either to the interior of an object, to the border, or to both. Effects 
add dimension and contrast between the object and its background. These effects can be found in the Property 
inspector (Figure 1) and in the Fill pane, the Stroke pane, and the Filters pane. Each effect has variables you can 
change to customize how the effect looks. The effects are described in the following sections. 

 

 
Figure 1 Property inspector 

Filters Pane 

Adjust Color 

 Auto Levels: Same as the Levels filter, but Fireworks automatically changes the lightest to darkest pixel range. 

 Brightness: Make the object brighter or darker. 

 Contrast: Increase or decrease the distinction between light and dark. 

 Color Fill: Place another color on top of the object and change how transparent it is and/or how it blends with 
the original color. 

 Curves: Adjust any color along the tonal range (the light to dark spectrum) without affecting other colors. 

 Hue/Saturation: Adjust the color by allowing change of the purity and lightness of the color in the image. 

 Invert: Change the colors to the inverse color on the color wheel. For example, apply Invert to a red object to 
change its color to light blue. 

 Levels: Change the tonal range (the light to dark spectrum) by changing the number of pixels that are 
highlights, midtones, or shadows. 

Bevel 

Each of these filters has attributes to alter the effect. You can alter the bevel’s color, the type of bevel (inner or 
outer), the shape of the bevel edge (flat, smooth, sloped, and so on), its contrast, its softness, and the angle of light 
that falls on it. 

 Inner Bevel: Give an object a 3-D look by making the inside of the object look lower than the outside of the 
object. 

 Outer Bevel: Give an object a 3-D look by making the inside of the object look higher than the outside of the 
object. 
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Emboss 

Emboss filters have attributes to alter the way the embossing looks. You can alter the image’s width, contrast, and 
softness and the angle of light that falls on it. 

 Inset Emboss: Make an image appear inset from its background. 

 Raised Emboss: Make an image appear raised from its background. 

Blur 

 Blur the pixels in an image. 

 Blur More: Blur three times as much as Blur. 

 Gaussian Blur: Apply a weighted average of blur to each pixel to produce a hazy effect. 

Noise 

The noise filter simulates the natural occurrence of image coloring being composed of pixels of many different 
colors. Noise refers to the random color variation of pixels that make up an image. You can apply color noise or 
monochrome noise. The amount of noise can be adjusted from 1 to 400, with an increase in amount resulting in 
more randomly placed pixels. 

Other 

 Convert to Alpha: Convert an object into a gradient transparency based on the transparency of the image. 

 Find Edges: Identify the color transitions and change those transitions to lines to give a sketched look. 

Shadow and Glow 

These filters simulate different angles of light falling on the object. Each of these filters has attributes to alter the 
effect. You can alter the shadow or glow’s color, the distance of the shadow from the object or width of the glow, 
the opacity of the shadow or glow, its softness, and the angle of light that falls on a shadow or offset of the glow 
from the object. 

 Drop Shadow: Make the object appear to be casting a shadow. 

 Glow: Make the object appear to glow. 

 Inner Glow: Highlight the object. 

 Inner Shadow: Darken the object so it looks as though something is casting a shadow on it. 

 Solid Shadow: Create a shadow streak in the shape of the object in any direction. 

Sharpen 

Sharpen adjusts the focus of a blurred image. 

 Sharpen More: Adjust the focus three times more than Sharpen. 

 Unsharp Mask: Adjust the contrast of the image edges to sharpen an image. 

Eye Candy 4000 LE 

Eye Candy 4000 LE filters have attributes to alter the effects. Because Eye Candy combines many of the previously 
mentioned filters, there are combinations of sub-attributes to alter for customizing the effect of Eye Candy. 

 Bevel Boss: Create a beveled, embossed, and highlighted look all at once. 

 Marble: Create a marbled look. 

 Motion Trail: Draw a trail from the object to simulate rapid movement. 
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Alien Skin Splat LE 

You can use the Alien Skin Splat LE Edges filter to diffuse a shadow by using several effects. You can adjust the 
width, margin, size, color, direction, transparency, and speed of the diffusion. 

Fill Effects 

Fill effects alter only the inside of an object. These effects add texture to a graphic or text object. The bottom of the 
menu list under Fill contains various gradient effects: linear, radial, ellipse, and so on. Following are the items at the 
top of the menu list. 

 None (white box with red diagonal line): Use no color to fill the object. 

 Solid: Fill the object with a solid color. 

 Web Dither: Approximate colors not in the current palette. 

 Pattern: Create a textured pattern as the fill 

Stroke Effects 

Stroke effects alter only the stroke or outline of a graphic or text object. In this pane you can change the type of 
medium used to create the outline. Each medium has options such as the tip size, the texture of the ink, and the 
sharpness of the pen tip. Following are the mediums available: 

 Basic: Several types of pens. 

 Air Brush: Several types of air brushes. 

 Calligraphy: Several types of calligraphy pen tips. 

 Charcoal: Several colors and types of charcoal pens. 

 Crayon: Several types and colors of crayons. 

 Dashed: Several types of dashed lines. 

 Felt Tip: Several types of felt pens. 

 Oil: Several types of oil paint brushes. 

 Pencil: Several types of pencils. 

 Watercolor: Several types of watercolor brushes. 

 Random: Several types of elements surrounding the object (confetti, fur, dots, rectangles, yarn). 

 Unnatural: Several looks created with multiple pens to the stroke of the object (3-D, 3-D glow, chameleon, 
fluid splatter, outline, paint splatter, toothpaste, toxic waste, and viscous alien paint).
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Nameplate Interview 

Name: _______________________________________________________ Date:________________________ 

Name of Student Interviewed: ____________________________________________________________________ 

 

What Fireworks tools did you use to create your nameplate? (List below.) 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

What effects did you use? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Describe, step by step, how you created your nameplate. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________





 Activity 1.8 Worksheet 

 Logo Review and Redesign   1 - 103 

Logo Review and Redesign 

Student Name: ________________________________________________ Date: _______________________ 

Summary 

Answer the following questions, which will help you think about reviewing and redesigning your logo. 

 Meeting initial goals 

 Requiring new goals 

 Reflecting good design principles 

 Redesign changes 

Meeting Initial Goals 

What were your initial goals for the logo? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 
Does the logo you have match the initial goals? Why or why not? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 



Activity 1.8 Worksheet 

1 – 104   Logo Review and Redesign 

Requiring New Goals 

Do you have new goals in mind for the logo? If so, what are they and why? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

Reflecting Good Design Principles 

What design concepts and principles did you originally incorporate into the logo? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 
Are there new design concepts or principles you want to include in your logo? If so, what are they and why? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 



 Activity 1.8 Worksheet 

 Logo Review and Redesign   1 - 105 

Redesign Changes 

What changes do you need to make to match your initial goals? Storyboard (sketch or draw) the changes in addition 
to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 
What changes do you need to make to account for the new design concepts and principles? Storyboard the changes 
in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________





 Activity 1.10 Guide 

 How to Create a Page Banner   1 - 107 

How to Create a Page Banner 

The purpose of a page banner is to establish a consistent identity on all pages so viewers know they are on a page of 
your website and recognize what the website is about. 

Create a Page Banner 

1. Start Macromedia Fireworks 8. 

2. Create a new file with dimensions at least 400 pixels 
wide and 100 pixels high. (Match your banner width to 
the pixel width of the web page you’re designing.) 

3. Turn on Guides and Rulers from the View menu so you 
can align banner elements easily. 

4. Use the Rectangle or Ellipse tool to create a 
background shape (such as a rectangle or oval) for the 
page banner. 

5. Add effects to the background shape. 

6. Add text to the banner. 

7. Add effects to the text, as you desire (Figure 1). 

8. Add images to your banner, as you desire. 

 The illustrations to the right show the effects used in the 
Property inspectors for the text (Figure 2) and the 
background ellipse (Figure 3) in the sample banner. 

9. Save the file. 

10. Export the file as a GIF or JPG image, depending on the 
level of color gradation or the presence of photographic 
elements in the banner. 

 
Figure 1 Sample banner 

 

 
Figure 2 Text effects in sample banner 

 

 
Figure 3 Shape effects in sample banner 





 Activity 1.11 Worksheet 

 Page Banner Review and Redesign   1 - 109 

Page Banner Review and Redesign 

Student Name: ________________________________________________ Date: _______________________ 

Reviewer Name: ______________________________________________ 
 

Designer Notes 

What were your initial goals for the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

Reviewer Evaluation 

Does the page banner match the initial goals? Why or 
why not? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

What design concepts and principles did you incorporate 
into the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

Are there new design concepts and/or principles that 
could be included in the page banner? If so, what are 
they and why? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
 



Activity 1.11 Worksheet 

1 – 110   Page Banner Review and Redesign 

Designer Notes 

How was each design concept intended to contribute to 
communicating the purpose of the page banner? 
 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

Reviewer Evaluation 

Do the design concepts chosen contribute to 
communicating the purpose of the page banner? Why or 
why not? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

Do you have new goals in mind for the page banner? If 
so, what are they and why? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

How might the new goals be incorporated into the page 
banner? 

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  

___________________________________________  
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 Page Banner Review and Redesign   1 - 111 

Designer’s Redesign 

What changes need to be made to match your initial goals? Please sketch or draw the changes in addition to writing 
about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

 

 

 

 

 

 

 

 

 

 
What changes do you need to make to account for the new design concepts and principles? Please sketch or draw 
the changes in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 

 

 

 

 

 

 

 



Activity 1.11 Worksheet 

1 – 112   Page Banner Review and Redesign 

What changes do you need to make to use the design concepts to better communicate the purpose of the page 
banner? 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

 
What changes do you need to make to match your new goals and requirements? Please sketch or draw the changes 
in addition to writing about them. 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________ 

____________________________________________________________________________________________



 Activity 1.11 Guide 

 Review and Redesign Presentation Topics   1 - 113 

Review and Redesign Presentation Topics 

Here are some suggestions for organizing a presentation on redesign. 

 What did your original design look like? 

o Show original file. 

o Describe initial goals, design concepts, and requirements.  

 What was the reviewer’s evaluation? 

o What parts adhered to the original intent, goals, and concepts?  

o What parts didn’t adhere to the original intent, goals, and concepts?  

 What new ideas did the reviewer propose? 

o What is the redesign?  

o Show new page banner.  
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